
II NNSSTTAALL LL AATTII OONN  II NNSSTTRRUUCCTTII OONNSS  

Table of Contents 
Installation Instructions 1 

Table of Contents 1 

System Requirements 2 

Installation 3 

Selecting where to Install the Professional Server 3 

Running the Installation 4 

Upgrade Instructions 10 

Running the Upgrade 11 

Installing Professional Edition Clients 12 

Configuration for Professional Client Access 13 

 



System Requirements 

Database Oasis Installation Instructions 2

System Requirements 
Before installing Database Oasis, you should verify that your computer meets the recommended system 
requirements. 

Operating System 
Database Oasis is compatible with Windows operating systems including Windows 2000 and later. 
You must have the latest service packs available from Microsoft® installed on your computer. 

RAM 
You will need a minimum of 256MB of RAM to operate Database Oasis. It is recommended that 
you have 512MB of RAM. 

Screen Resolution 
Your screen resolution must be set to at least 800x600. Setting your resolution to 1024x768 or 
greater is recommended. 

Hard Drive Space 
The Database Oasis application will initially require 30 MB to install. You will need additional hard 
drive space as you use the software and add data. You are able to store up to 4TB (Terabytes) of data 
in Database Oasis. 
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Installation 
There are three different types of Database Oasis installations: 

·  Basic Edition is a single-user product that is installed and used on one computer. 

·  Professional Edition is a multi-user product. The database is installed on one computer on the 
network, then accessed by other computers over the network. This primary installation is called 
the server. 

·  Professional Edition clients are installed at each machine that needs to use Database Oasis. They 
are exactly like the server, except that the database isn’t installed locally. Instead, they access the 
database located on the server. 

If you will be using Database Oasis - Basic Edition, you will simply need to install the software on the 
computer you will be using to work with your data. 

If you will be using Database Oasis - Professional Edition, you will need to select where you want to 
install the server. 

Selecting where to Install the Professional Server 

   This feature is only applicable to Database Oasis Professional Edition. 

If you will be using Database Oasis - Professional Edition, chances are you will need to access the 
software from more than one computer. In this case, you need to decide which computer will host 
the data. When choosing where to install the data server, keep the following points in mind: 

·  The computer where the data resides will need to be accessible on your network to all of the 
computers that will be using Database Oasis. 

·  The computer where the data resides will need to be turned on and logged into Windows 
when other people want to use the software. 

Once you’ve decided where to install the server, you can perform the client installation on any other 
computers that will need to access Database Oasis. 
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Running the Installation 
There are two installation programs. 

DBOasisSetup.exe This installation file is used to install Database Oasis - Basic Edition, and 
the Server installation of Database Oasis - Professional Edition. This file 
installs Database Oasis and the database files. 

DBOClientSetup.exe This installation file is used to install Client installations of Database Oasis - 
Professional Edition. This installation file just installs Database Oasis and 
not the database. This is used for Professional Clients that will access the 
database installed on the Professional Server.  

RUNNING THE BASIC EDITION AND PROFESSIONAL SERVER 
INSTALL  

1 If you have not already done so, download the Database Oasis installation using the 
download link on the www.databaseoasis.com website. 

2 Launch the DBOasisSetup.exe file that you downloaded. The installation files will be 
extracted and the Setup wizard will launch to guide you through the installation: 

 

3 This screen checks your computer to see if components necessary to run Database 
Oasis are already installed. Database Oasis incorporates the latest Microsoft© 
Technologies. Depending on whether any of the applications you currently have 
installed on your computer make use of these technologies, the install program may 
need to download and install version 2 of the Microsoft .Net Framework from 
Microsoft. This framework will be used with Database Oasis and any future software 
applications you install that take advantage of these new technologies. If the latest 
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framework already exists on your computer, this step will be skipped and you can 
move directly to step 7 of these instructions.  

4 Click Next to begin the scan for required components. If the .NET Framework V2.0 
is not found, you will be asked to accept the license agreement prior to download and 
installation: 

 

5 Read the terms of the agreement and click Accept to continue with the installation. If 
the .NET framework needs to be installed, it will be downloaded from Microsoft’s 
website. 

6 Once the download is complete, a status bar will appear as the files are installed. 
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7 Once the framework is installed, the Database Oasis installation will begin and the 
following screen will appear: 

 

8 Click Next > to continue. The license agreement screen will open: 
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Note 

 If a Program Maintenance screen appears instead of 
the License Agreement screen, you already have this 
version of the software installed. 

9 Please read the license information carefully. If you do not accept the terms of this 
agreement, click Cancel to abort the installation. If you do accept the terms of the 
agreement, select the I Agree radio button and click Next > to continue.  

10 The following page will open: 

 

11 This allows you to specify a location for your installation of Database Oasis. It is 
recommended that you install to the default location in the \Program Files folder. If 
you wish to install to a different location, click the Browse… button and select the 
target folder.  
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12 Click Next > to continue. The Confirm Installation screen will open: 

 

13 Click Next> to begin installing Database Oasis. A progress screen will appear as the 
software is installed: 
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14 Once the installation process is complete, the following screen will appear: 

 

15 Click Close to exit the wizard.  
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Upgrade Instructions 
Prior to upgrading, please review the following: 

·  Before running an upgrade, make sure to back up your existing installation using the Backup 
option on the Tools menu. 

·  If you are upgrading from version 2.7 or earlier, the data was stored in a Microsoft SQL 
Server Express database. When migrating from SQL: 

o Make sure that SQL server is running (you are able to work with data in Database 
Oasis). 

o Although access to the SQL server is happening locally on your computer and not 
going out over the Internet, some firewall software may try to block it. If you receive 
a message that Database Oasis is trying to access the Internet, select to allow the 
access. If the access gets blocked, Database Oasis will not be able to connect with the 
existing SQL database.  

·  If you are upgrading Database Oasis - Professional Edition: 

o Make sure all clients are logged off before proceeding.  

o Make sure all clients are upgraded prior to trying to connect to the server.  You will 
not be able to log on from a client that has not been upgraded. 

Note 

 If you upgrade a client before upgrading the server, 
the database will be automatically upgraded when you 
first log on from the client. At that point, you will not 
be able to log on from the server until it has also been 
upgraded. 

·  If you are upgrading from a version of Database Oasis prior to version 2.6 

o There is no direct upgrade path from version 2.5 and earlier to version 2.9. You must 
first upgrade to version 2.7, then run the latest upgrade. The 2.7 installation can be 
downloaded from our website at: http://www.databaseoasis.com/dboasissetup27.exe  

o A change was made to the way logos are stored starting in version 2.6. Prior to this 
version, a link was created to the graphic file on your hard drive or network. After 
v2.6, a change was made to store a copy of the graphic in the database, allowing users 
to distribute templates without having to distribute separate graphic files. Users 
upgrading from version 2.5 or earlier will need to open any displays with logos in the 
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designer. A conversion process will be run to embed the graphic. (There is no need to 
open each logo separately; the conversion runs as soon as the designer is opened.) 

Running the Upgrade 
If you have an older version of Database Oasis and would like to upgrade to a newer version, simply 
run the install as you would for a new installation.  

If you are running Professional Edition, you may download the client upgrade at: 
http://www.databaseoasis.com/dboasisclientinstall.exe  

When upgrading a Professional Edition Client, launch the dboasisclietinstall.exe file and use the 
installation wizard to guide you through the install process. 

If you have not already done so, you may download the Basic Edition and Professional Edition 
server upgrade at:  http://databaseoasis.com/DBOasisSetup.exe  

When upgrading a Basic Edition or a Professional Edition Server, launch the DBOasisSetup.exe file 
and use the installation wizard to guide you through the installation process. Once the initial files 
have been installed, the install program will search for previous version data. If it is found, it will be 
upgraded.  

If the installation program is unable to locate the data, the Specify the Database Type page will open, 
allowing you to select whether you would like to scan again for the data, or create new data files 
without upgrading. 

 
This page most commonly appears when you are upgrading from version 2.7 and your data is in a 
Microsoft SQL Express database. An additional scan is required to search your network for the 
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existence of Microsoft SQL server. If found, it will access SQL to determine if there is an instance of 
Database Oasis that contains data which needs to be upgraded and migrate the data. 

To attempt again to upgrade, select the Scan for the previous version’s data and upgrade radio button 
and click Next. If the data is found, the upgrade procedure will migrate your data from Microsoft 
SQL Server to the VistaDB database.  

If the scan is still unable to locate the data, or a connection cannot be made, you will receive a 
message giving you the option to try the scan again, install a new database, or cancel. 

·  If you would like to try to scan again, try correcting the connection issue and select Yes at 
the message to scan again. If it is successful the data will be migrated. 

·  If you would like to bypass the upgrade and install a new database, select No at the message. 
Existing data will not be upgraded. 

·  If you would like to stop the upgrade process and get additional help on locating or 
connecting to your data select Cancel and contact Support@DatabaseOasis.com for 
assistance with converting your data. You can simply run the installation again later to 
complete the upgrade process. 

Installing Professional Edition Clients 

   This feature is only applicable to Database Oasis Professional Edition. 

If you are using Database Oasis Professional Edition, you should install the software on any client 
machines that will need to access Database Oasis. 

RUNNING THE PROFESSIONAL CLIENT INSTALL  

1 If you have not already done so, download the Database Oasis client installation from 
http://www.databaseoasis.com/dboasisclientinstall.exe.  

2 Launch the DBOasisClientInstall.exe file that you downloaded. The installation files 
will be extracted and the Setup wizard will launch to guide you through the 
installation. 

3 Follow the installation steps using the guidelines under Running the Basic Edition 
and Professional Server Install, above. 

4 Click Close to exit the wizard. (See Clients & Users in Professional Edition in your 
Database Oasis user manual for help with client configuration.) 
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Configuration for Professional Client Access 
In a network environment, in order for the clients to access the data over the network, you will need to 
set up a network share to the data file. 

CREATING A NETWORK SHARE  

Note 

 There may be slight differences in the procedure for 
sharing data, depending on your operating system and 
security settings. These steps provide an overview of 
common configuration options, but do not cover all 
possible variables.  

 For comprehensive help with configuring a share in 
Windows XP, refer to the article 
http://support.microsoft.com/kb/304040.  

 For help in Windows 2000, refer to the article 
http://support.microsoft.com/kb/301195.  

 For help in Windows Vista, refer to the article 
http://www.microsoft.com/technet/network/evaluate/v
ista_fp.mspx.  

 For help in Windows 7, refer to the article 
http://windows.microsoft.com/en-
us/windows7/Share-files-with-someone.  

1 On the computer where Professional Edition is installed, double click on the My 
Computer icon on your desktop: 
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2 The My Computer screen will open: 

 

3 Navigate to the Database Oasis data path. For operating systems prior to Windows 
Vista, the data is located in the path C:\Documents and Settings\All 
Users\Application Data\DBOData. In Windows Vista and Windows 7, the data is 
located in the path C:\ProgramData\DBOData\.  

Note 

 If you do not see the \DBOData folder, it is usually 
because it is hidden in Windows. To unhide the 
folder, right click on your Windows Start button and 
select Explore from the menu to open Windows File 
Explorer. Select Folder Options from the Tools menu, 
then select the View tab. Make sure that the Show 
hidden files and folders option is selected. 
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4 Right click on the \DBOData folder and select Sharing and Security or Share 
(depending on your version of Windows) from the right-click menu: 
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5 The Sharing tab of the Properties screen for the \DBOData folder will open: 

  

Note 

 Depending on your version of Windows, you may 
need to press the Advanced Sharing button on the 
Properties screen to access the sharing options. 

Note 

 If you have never created a network share, this screen 
will have a link to a wizard where you can set up file 
sharing. Follow the on-screen instructions in the 
wizard, if desired. 

6 Select the Share this folder check box or radio button (depending on your version of 
Windows). This option will make the \DBOData folder accessible to clients on the 
network. 



Installing Professional Edition Clients 

Database Oasis Installation Instructions 17

WARNING! 

 If an outside user is able to access your network, any 
shared folders will be available. Make sure that you 
have security on your network to prevent outside 
access, especially if you are using a wireless network. 

7 Select the Security tab: 

 

Note 

 Depending on your version of Windows, you may 
need to click Edit to open a separate Permissions 
screen to change these settings. 

8 Verify that there is a group named Everyone in the Group or user names list. If there 
is, skip to step 12. 
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WARNING! 

  Selecting the Everyone group gives anyone who is 
able to access your network access to the folder. 
Configuring the Everyone group is the easiest way to 
ensure clients will be able to access the software 
when there is not a security scheme in place. If you 
have group security in place, it is recommended that 
you select groups and/or users that reflect your 
security configuration rather than using Everyone. 

9 If there is no Everyone group, click Add. The Select Users or Groups screen will 
open: 

 

10 In the Enter the object names to select box, type Everyone. 

11 Click OK to save the group and return to the Security tab. 

12 Highlight the Everyone group in the Group or User Names list and select the Full 
Control check box in the Permissions for Administrators box. 

13 Click OK to save the changes and close the Properties screen. 

Testing the Folder Share 
Once you’ve configured your share, it is recommended that you test it outside of Database Oasis by 
trying to access that folder in Windows Explorer from the client computer.  

TO TEST THE PERMISSIONS: 

1 On the client computer, right click on the Windows Taskbar’s Start button and select 
Explore from the menu. 
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2 In the Folders list, select Network or My Network Places (depending on your version 
of Windows). 

3 Navigate to your server computer and make sure you can see the Database Oasis data 
folder in the list.  

Note 

 To navigate to the computer in Windows XP, select 
Entire Network, then Microsoft Windows Network 
under the My Network Places link. 

4 Click on the Database Oasis data folder and make sure you can open it. 

5 With the folder selected, right click in the files section on the right and select New, 
Text Document from the menu and verify it allows you to create a text file in the 
folder. (You may delete the text file if desired.) 

If you are unable to access the folder and create a new file in the folder, clients will not be able to access 
the Database Oasis data. In this case, check the following: 

·  On the server computer, verify in Windows that the Guest account is turned on. (Refer to 
Microsoft Windows help for instructions on turning on the Guest account in your version of 
Windows.) 

·  Verify that the folder share has been correctly configured using the above instructions.  

Note 

   If you are able to access an existing folder share that is 
working, compare setting with the new share to 
determine the differences. 

·  Depending on the version of Windows and internal security settings, Windows may not allow 
you to grant full access to the default data path. In this case, you may need to move the 
\DBOData folder directly under the C:\ drive. 

 


